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Composants d'habillage
Dans ce cours vous apprendrez à positionner des composants d'habillage sur des pièces.

Sujets traités :

Etude de cas : Capot supérieur
Objectif de la conception
Etapes du processus
Application d'une dépouille
Création d'un raidisseur
Création de filetages et de taraudages
Edition de composants



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              5-2

Etude de cas : Composants d'habillage

L'étude de cas pour cette leçon est un capot utilisé dans l'assemblage de la perceuse à colonne 
(illustré ci-dessous). Cette étude de cas se concentre sur l'intégration de l'objectif de conception lors 
de la création de cette pièce. 



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              5-3

Le capot supérieur doit correspondre aux prérequis suivants de l'objectif de conception :

Objectif de la conception

� Les nervures intérieures doivent être créées à l'aide des 
composants de raidisseur.

� L'utilisation de composants de raidisseur  est la méthode la plus 
efficace de création de cette géométrie.

� Le capot doit contenir une dépouille de 4 degrés.

� Cette pièce va être fabriquée par moulage. Une dépouille est 
donc nécessaire.

� Le capot doit avoir des taraudages définis pour tous les 
trous.

� Des taraudages peuvent être représentés de façon simple, 
sans avoir à créer de géométrie complexe ; cette dernière peut 
prendre beaucoup de temps et de ressources pendant les 
cycles de regénération.
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Etapes du processus

Les étapes suivantes seront utilisées pour créer le capot supérieur :

1. Application d'une
dépouille.

2. Création d'un raidisseur.

3. Création des filetages et 
des taraudages.

4. Modification de 
composants. 
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Application d'une dépouille
Dans cette section, vous allez apprendre à créer des dépouilles et comment appliquer 
différents types de dépouilles à une pièce.

Suivez ces étapes :

1. Application d'une
dépouille. 

2. Création d'un raidisseur.
3. Création des filetages et des 

taraudages.
4. Modification de composants.



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                              5-6

Selon 
config.

Selon 
config.

A propos de la dépouille (1/2)

Les composants de dépouille appliquent un angle à
une surface de pièce relativement à une référence. 
De la matière est ajoutée ou retirée selon l'angle et 
la direction de dépouille.
On parle de « direction d'extraction » (terme 
emprunté aux pièces moulées) dans le cadre de 
cette fonctionnalité. L'opération de dépouille 
appliquée à des pièces moulées leur permet d'être 
facilement retirées de leurs  moules. 
Il existe trois types de dépouille dans CATIA :

A. Dépouille simple

B. Dépouille à partir d'une 
ligne de reflet

C. Dépouille variable

A

B

C

A B C
Selon 
config.

Selon 
config.
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A propos de la dépouille (2/2)

Une dépouille simple requiert la définition de trois 
critères :
A. Direction d'extraction : 

� La direction d'extraction définit la 
direction à partir de laquelle l'angle de 
dépouille est mesuré. Il s'agit de la 
direction dans laquelle les côtés d'un 
moule sont tirés lors de l'extraction du 
moule.

B. Angle de dépouille : 

� L'angle de dépouille est l'angle que 
forment les faces de la dépouille et la 
direction d'extraction par rapport à
l'élément neutre. Il peut être défini pour 
chaque face.

C. Elément neutre : 

� L'élément neutre est utilisé pour définir le 
pivot des surfaces dépouillées. Les 
surfaces dépouillées se déplacent autour 
d'une courbe neutre, le pivot, sur 
l'intersection avec l'élément neutre. 
L'élément neutre, normalement un plan 
ou une surface, peut être la même 
référence utilisée pour la direction 
d'extraction.

B

cA
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Dépouilles simples (2/2)

Suivez ces étapes pour appliquer une dépouille 
(suite) :

4. Spécifiez l'élément neutre.

5. Spécifiez la direction d'extraction.

6. Cliquez sur OK.

4

5

6

Selon 
config.
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Dépouilles simples (2/2)

Suivez ces étapes pour appliquer une dépouille 
(suite) :

4. Spécifiez l'élément neutre.

5. Spécifiez la direction d'extraction.

6. Cliquez sur OK.

4

5

6

Selon 
config.
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Vous pouvez appliquer des dépouilles à des surfaces qui 
ne sont pas planaires, telles que des cylindres. Vous 
pouvez créer des dépouilles à partir de lignes de reflet 
générées pour une surface dans une direction donnée. 

Suivez ces étapes pour appliquer une dépouille à partir 
d'une ligne de reflet :

Dépouille à partir d'une ligne de reflet (1/2)

1. Cliquez sur l'icône Dépouille à partir d'une ligne 
de reflet.

2. Sélectionnez la surface à laquelle appliquer la 
dépouille.

3. CATIA affiche automatiquement la direction 
d'extraction par défaut. Pour spécifier une autre 
direction, cliquez sur la zone Pulling Direction 
(Direction d'extraction) et sélectionnez une 
nouvelle référence.

4. CATIA calcule les lignes de reflet basées sur la 
direction d'extraction.

1

2

Selon 
config.
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Suivez ces étapes pour appliquer une dépouille à
partir d'une ligne de reflet (suite) :

Dépouille à partir d'une ligne de reflet (2/2)

5. Dans cet exemple, la dépouille pourrait 
être créée de façon indéfinie, mais ici 
nous devons définir une limite. Cliquez 
sur le bouton More (Plus) et 
sélectionnez le plan particulier comme 
élément de joint.

6. Cliquez sur Preview (Aperçu)

7. Cliquez sur OK pour terminer la 
création du composant.

5

5
67

Selon 
config.
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Dépouille variable (1/2)

Dans certaines situations vous pouvez avoir besoin de 
créer une dépouille avec des angles différents aux arêtes 
de transition. Vous pouvez obtenir ce résultat en utilisant 
une dépouille variable. 

Suivez ces étapes pour créer un dépouille variable :

1. Cliquez sur l'icône Dépouille variable.

2. Sélectionnez la face sur laquelle la 
dépouille doit être appliquée.

3. Sélectionnez l'élément neutre.

1

2

3

Selon 
config.
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Dépouille variable (2/2)

Suivez ces étapes pour créer une dépouille 
variable (suite) :

4. CATIA détermine les zones de transition qui 
peuvent avoir des angles de dépouille 
différents. Elles apparaissent sur le modèle 
et vous pouvez les modifier en double-
cliquant sur les cotations. 

5. Cliquez sur OK pour terminer la création du 
composant.

Selon 
config.
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Sélection de faces à dépouiller

Vous pouvez créer des composants de dépouille sur :

A. Plusieurs faces : dans cet 
exemple, une dépouille est 
appliquée aux quatre faces 
latérales.

B. Faces individuelles : dans cet 
exemple, une dépouille est créée 
pour chacune des quatre faces 
latérales.

A

B

Selon 
config.

Selon 
config.

Selon 
config.

Selon 
config.
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Utilisation de l'outil Analyse de dépouille 

L'outil Analyse de dépouille identifie (à l'aide de codes 
de couleur) et met en évidence les zones qui dévient 
des valeurs spécifiées pour une direction de dépouille 
définie.

Pour exécuter une analyse de dépouille, procédez 
comme suit :

1. Définissez le style de rendu personnalisé.

2. Sélectionnez la pièce que vous voulez analyser.

3. Cliquez sur l'icône Analyse de dépouille.

4. Choisissez le mode d'analyse rapide.

5. Réglez la direction de la dépouille sur Z à l'aide 
de la boussole.

Observez les couleurs :

Vert : Valeur de dépouille supérieure à 5 degrés

Bleu : Sous 0 degré

Rouge : 0 – 5 degrés

1

4

3

2

Dans une pièce idéale, l'analyse aboutit à une zone 
bicolore (rouge et bleue) au niveau de la ligne de 
partage, correspondant aux deux moitiés d'un moule.
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Recommandations sur les dépouilles
Vous allez apprendre les méthodes spécifiques et les recommandations concernant les 
composants de dépouille.



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            5-17

Elément de joint et élément neutre

Dans tous les cas, utilisez la même référence pour l'élément de joint et l'élément neutre. 
Ceci vous évitera d'obtenir une géométrie non souhaitée. Dans l'exemple ci-dessous, deux 
dépouilles sont créées en utilisant un élément de joint commun mais des éléments neutres 
différents : pour cette raison, la zone de transition affiche une géométrie non satisfaisante.

PIÈCE 
D'ORIGINE

PIÈCE 
ESQUISSEEELEMENT 

NEUTRE

ELEMENT 
NEUTRE

ELEMENT 
DE JOINT

GEOMETRIE NON 
SATISFAISANTE

En développant la boîte de dialogue 
Draft (Dépouille) vous pouvez utiliser la 
même référence pour l'élément Parting
element (Élément de joint) et l'élément 
Neutral element (Élément neutre).
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Création de congés après des dépouilles

Dans l'exemple présenté, 

1. L'objectif de conception nécessite que la 
valeur de chaque congé d'arête reste 
constante pendant toute la durée de la 
conception et du développement de la pièce.

2. Si une dépouille est appliquée sur une surface 
avec congé, les valeurs du congé ne restent 
plus constantes.

Pour contrôler la valeur du rayon du congé et 
conserver un rayon constant, il est nécessaire de 
créer une dépouille avant un congé.

2

1

1
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Ordre des composants d'habillage

Dans tous les cas, créez les pièces dans l'ordre suivant :

1. Composants principaux de pièce (par exemple, extrusions, poches, révolutions)

2. Dépouilles

3. Congés

4. Coques

1

3

2

4
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Création d'un raidisseur
Dans cette section vous découvrirez le rôle d'un raidisseur et vous le créerez.

Suivez ces étapes :

1. Application d'une dépouille. 
2. Création d'un raidisseur.
3. Création des filetages et des 

taraudages.
4. Modification de composants.
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Présentation des raidisseurs

Dans CATIA, les raidisseurs sont créés 
en extrudant un profil d'esquisse ouvert et 
en ajoutant de l'épaisseur.

Vous pouvez procéder de deux façons :

A. Simple 

� L'esquisse est extrudée dans le plan 
de profil et elle est épaissie 
normalement à ce plan. 

B. Réseau
� L'esquisse est épaissie dans le plan 

de profil et extrudée normalement à
ce plan.

A

B
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Création de raidisseurs (1/2)

Il est possible de créer des raidisseurs sans 
composant de raidisseur. Par exemple, dans 
certains cas, vous pouvez utiliser le composant 
d'extrusion pour obtenir le même résultat.

Un raidisseur est créé à partir d'une droite 
ouverte, cependant, les droites fermées sont 
préférables pour la création de solides.
A la création d'un raidisseur, les extrémités de 
la ligne ouverte sont projetées sur la face la 
plus proche du corps actif. Si cette face 
disparaît suite à des modifications ultérieures, 
l'opération échoue et un message d'erreur 
s'affiche.

Dans le cas de la création du même type de 
géométrie avec un composant d'extrusion, une 
modification identique risque d'entraîner un 
résultat incohérent, mais le résultat sera visible 
et la modification à réaliser sera facile à
visualiser.
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Création de raidisseurs (2/2)
Dans l'exemple, les longueurs des faces avec 
angles sont réduites.

Pour le composant Stiffener.1, les extrémités 
de la ligne ouverte sont projetées sur la face 
la plus proche du composant Pad.1. La 
création du raidisseur échouera et un 
message d'erreur s'affichera.

Pour le composant Pad.3, les limites du 
composant sont les faces extérieures du 
composant Pad.2. Le résultat sera 
incohérent, mais visible, et l'intervention sera 
facile à déterminer.



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            5-24

Recommandations sur les raidisseurs
Dans cette section, vous découvrirez une recommandation qui peut vous aider lors de la 
création de raidisseurs.
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Eviter la création de raidisseurs

Il est recommandé d'éviter de créer un composant Stiffener (Raidisseur).

En voici la raison :
Les raidisseurs sont créés à partir de lignes ouvertes ; hors l'utilisation de lignes ouvertes pour 
la construction de solides dans CATIA est déconseillée.

Pourquoi ne pas utiliser de ligne ouverte ? 
A la création du raidisseur, les extrémités de la ligne ouverte sont projetées sur la face la plus 
proche du corps actif. Si jamais cette face disparaît suite à des modifications ultérieures, la 
fonction échoue. Bien sûr, si la ligne est entièrement contrainte, cette fonction peut aboutir, mais 
le raidisseur est un composant considéré comme moins stable qu'une extrusion, préférée dans 
ce cas.
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Exercice : Raidisseurs et dépouille
Exercice : Récapitulatif

20 min

Dans cet exercice vous créerez une pièce qui comprendra des raidisseurs et une 
dépouille. Cet exercice est accompagné d'instructions détaillées.

A la fin de cet exercice, vous serez capable de :

� Créer des raidisseurs

� Créer une dépouille
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C'est à vous ! (1/6)

1d

2a

1. Créez une nouvelle pièce.
� Pour créer un fichier de pièce, sélectionnez 

Part dans la boîte de dialogue New 
(Nouveau).

a. Cliquez sur File > New (Fichier > 
Nouveau).

b. Sélectionnez Part dans la boîte de 
dialogue New (Nouveau).

c. Cliquez sur OK.
d. Entrez un nom de pièce [Ex5A] et cliquez 

sur OK.
2. Création d'une extrusion. 

� Vous allez créer une esquisse positionnée du 
profil ci-contre et l'utiliser pour créer une 
extrusion.

a. Cliquez sur l'icône Esquisse positionnée.
b. Sélectionnez YZ plane (Plan YZ) comme 

référence d'esquisse.
c. Esquissez le contour.
d. Appliquez une contrainte à l'esquisse.
e. Quittez l'atelier Sketcher.
f. Créez l'extrusion.

2f
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�

C'est à vous ! (2/6)

3. Appliquez une coque à la pièce.
a. Cliquez sur l'icône Coque.
b. Cliquez sur la face indiquée pour 

qu'elle soit retirée.
c. Entrez [5mm] pour l'épaisseur 

intérieure.
d. Cliquez sur OK.

3a

3b
3c

3d
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�

C'est à vous ! (3/6)

4. Créez un raidisseur.
� Le raidisseur est créé entre deux faces 

perpendiculaires. Le mode From Side
(Simple) est utilisé.

a. Cliquez sur l'icône Esquisse 
positionnée.

b. Sélectionnez zx plane (Plan ZX).
c. Créez l'esquisse suivante.
d. Quittez l'atelier Sketcher.
e. Cliquez sur l'icône Raidisseur.
f. Sélectionnez l'esquisse Sketch.2 

(Esquisse.2) pour la référence de profil.
g. Vérifiez que vous êtes en mode From

Side (Simple).
h. Entrez [6mm] pour l'épaisseur 

Thickness1 (Epaisseur1).
i. Cliquez sur OK.

4c

4e

4h

4g
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C'est à vous ! (4/6)

5. Créez un raidisseur.
� Le raidisseur est créé par décalage d'une 

référence. Le mode From Top (Réseau) 
est utilisé.

a. Créez un plan de type Décalage.
b. Créez une esquisse positionnée sur le 

plan décalé.
c. Créez l'esquisse suivante.
d. Quittez l'atelier Sketcher.
e. Cliquez sur l'icône Stiffener

(Raidisseur).
f. Sélectionnez l'esquisse Sketch.3 

(Esquisse.3) comme la référence de 
profil.

g. Vérifiez que vous êtes en mode From
Top (Réseau).

h. Entrez [6mm] pour l'épaisseur 
Thickness1 (Epaisseur1).

i. Cliquez sur OK.

5a

5c
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�

C'est à vous ! (5/6)

6. Créez une extrusion.
� Pour montrer que la géométrie de raidisseur peut 

être créée en utilisant d'autres méthodes, ce 
composant sera créé comme une extrusion. 
Généralement, ce procédé nécessite plus 
d'étapes.

a. Cliquez sur l'icône Esquisse positionnée.
b. Sélectionnez ZX plane (Plan ZX).
c. Créez l'esquisse suivante.
d. Quittez l'atelier Sketcher.
e. Cliquez sur l'icône Pad (Extrusion).
f. Sélectionnez l'esquisse Sketch.4 (Esquisse.4) 

comme référence de profil.
g. Entrez [3mm] comme épaisseur Thickness1 

(Epaisseur1).
h. Sélectionnez l'option Mirrored extent

(Extension symétrique).
i. Cliquez sur OK.

6c
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C'est à vous ! (6/6)

7. Création d'une dépouille.
a. Cliquez sur l'icône Draft (Dépouille).
b. Sélectionnez les quatre faces extérieures sur 

lesquelles appliquer la dépouille.
c. Sélectionnez la surface comme élément neutre.
d. Entrez [10deg] comme angle.
e. Cliquez sur OK.

8. Fermez le fichier sans l'enregistrer.

7a

7b

7d

7c

7b
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�

Récapitulatif de l'exercice : Raidisseurs et dépouille

� Créer des raidisseurs
� Créer une dépouille
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Exercice : Dépouille de reflet
Exercice : Récapitulatif

20 min

Dans cet exercice, vous vous entraînerez à créer des dépouilles. Cet exercice est 
accompagné d'instructions de haut niveau.

A la fin de cet exercice, vous serez capable de :

� Création d'une dépouille élémentaire

� Création d'une dépouille de reflet

Selon 
config.
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�

C'est à vous (1/5)

1. Création d'une pièce.
� Créez une nouvelle pièce avec le set 

géométrique.
2. Création d'une révolution. 

� Vous allez créer une esquisse du profil ci-contre 
et l'utiliser pour créer une révolution.

a. Créez l'esquisse sur le plan YZ.
b. Créez une révolution de 360°

2

1
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�

C'est à vous (2/5)

3. Créez une dépouille élémentaire.
a. Sélectionnez les parois du cylindre comme faces à

dépouiller, et la surface supérieure comme 
élément neutre et comme direction d'extraction.

b. Entrez [6deg] comme angle de dépouille.

3
Selon 
config.
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�

C'est à vous (3/5)

4. Créez une dépouille à partir d'une ligne de 
reflet.

a. Créez un plan de référence décalé de 
[100 mm] du plan xy dans la direction 
négative. 

b. Sélectionnez la face du cylindre où
appliquer la dépouille à partir d'une ligne 
de reflet. 

c. Cliquez sur OK dans la boîte de dialogue 
Feature Definition Error (Erreur de 
définition du composant).

d. Définissez le plan de décalage déjà créé
comme élément de joint.

e. Définissez le plan de décalage déjà créé
comme direction d'extrusion.

f. Vérifiez que la direction d'extraction est 
correcte.

4c

4d
4e

4b

4f

Selon 
config.
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�

C'est à vous (4/5)

5. Création d'une poche.
a. Sélectionnez la surface supérieure de l'extrusion et 

tracez le profil suivant. Utilisez la face existante de 
l'extrusion pour créer un décalage de [10 mm]. 

b. Créez une poche d'une profondeur de [50 mm].

5a

5b
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�

C'est à vous (5/5)

6. Création d'un congé d'arête.

a. Sélectionnez les arêtes autour des 
contours supérieurs et inférieurs, et 
spécifiez une valeur de rayon de [5mm].

7. Cacher toutes les contraintes.

8. Enregistrement et fermeture du fichier.

6a

Selon 
config.
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�

Récapitulatif de l'exercice : Dépouille de reflet

� Création d'une dépouille
élémentaire

� Création d'une dépouille de 
reflet

Selon 
config.

Selon 
config.
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Exercice : Raidisseurs et dépouille
Exercice : Récapitulatif

10 min

Dans cet exercice vous exploiterez les compétences que vous avez acquises pour 
créer une pièce contenant une dépouille et quatre raidisseurs.  Vous utiliserez les 
outils que vous avez découverts dans les exercices précédents pour réaliser cet 
exercice sans instructions détaillées.

A la fin de cet exercice, vous serez capable de :

� Créer une pièce

� Appliquer une dépouille à une pièce

� Créer des raidisseurs
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�

C'est à vous !

1. Créez la pièce suivante.
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�

Récapitulatif de l'exercice : Raidisseurs et dépouille

� Créer une pièce
� Appliquer une dépouille à une pièce
� Créer des raidisseurs
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Création de filetages et de taraudages
Dans cette section vous apprendrez à créer des filetages et des taraudages.

Suivez ces étapes :

1. Application d'une dépouille. 
2. Création d'un raidisseur.
3. Création des filetages 

et des taraudages.
4. Modification de 

composants.
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A propos des filetages et des taraudages (1/2)

Un filetage est une gorge hélicoïdale située à
l'extérieur d'une dépouille cylindrique, alors 
qu'un taraudage est une gorge hélicoïdale à
l'intérieur d'un trou cylindrique.

Dans CATIA, la géométrie en cours de travail 
de filetage et de taraudage n'est pas affichée. 
Elle est représentée sur la pièce de façon 
symbolique. Les composants incluent les 
paramètres qui définissent les géométries de 
filetage et taraudage souhaitées, telles que le 
diamètre, le pas et la longueur. 

Taraudage Représentation CATIA

Filetage Représentation CATIA
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A propos des filetages et des taraudages (2/2)

La boîte de dialogue Thread/Tap Definition
(Définition du trou) vous permet de 
spécifier les éléments de choix suivants :
A. Les surfaces sur lesquelles le filetage ou 

le taraudage est positionné.

B. La surface de démarrage du filetage ou 
du taraudage.

C. CATIA dispose déjà de deux standards. 
Vous pouvez ajouter un standard 
personnalisé en sélectionnant le bouton 
Add (Ajout).

D. Les caractéristiques du 
filetage/taraudage, qui peuvent différer 
en fonction du standard appliqué. 

A
B

C

D
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Filetage et taraudage (1/2)

Suivez ces étapes pour créer un 
filetage/taraudage :

1

2

3

4
5

6

1. Cliquez sur l'icône Thread/Tap 
(Filetage/Taraudage).

2. Sélectionnez la face latérale sur laquelle 
le taraudage sera creusé.

3. Sélectionnez la face de référence à
partir de laquelle le taraudage 
commencera.

4. Dans cet exemple, le type de pas 
Metric Thin Pitch (Métrique pas fin) 
est sélectionné.

5. Choisissez le diamètre du taraudage.

6. Spécifiez une valeur dans le champ 
Thread Depth (Profondeur taraudage).
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Filetage et taraudage (2/2)

Suivez ces étapes pour créer un 
filetage/taraudage (suite) :

7. Cliquez sur le bouton Preview (Aperçu) 
dans la boîte de dialogue. 

8. Cliquez sur OK pour terminer le 
taraudage. 

7

8

La géométrie du taraudage ou du filetage 
n'apparaît pas sur le modèle mais dans 
l'arbre des spécifications. Elle peut 
également être affichée dans la vue de 
dessin.
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Exercice : Filetage et taraudage
Exercice : Récapitulatif

20 min

Dans cet exercice vous créerez une nouvelle pièce, un composant filetage/taraudage, 
vous réorganiserez certains composants en rapport avec l'objectif de conception et 
vous modifierez des propriétés de composant. Cet exercice est accompagné
d'instructions détaillées.

A la fin de cet exercice, vous serez capable de :

� Créer un filetage/taraudage

� Réorganiser un composant

� Modifier les propriétés d'un 
composant
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C'est à vous ! (1/11)

1. Créez une nouvelle pièce.
� Pour créer un fichier de pièce, 

sélectionnez Part (Pièce) dans la boîte 
de dialogue New (Nouveau).
a. Cliquez sur File > New (Fichier > 

Nouveau).
b. Sélectionnez Part dans la boîte de 

dialogue New (Nouveau).
c. Cliquez sur OK. 
d. Spécifiez un nom de pièce [Ex5D] et 

cliquez sur OK.

2. Création d'extrusions. 
� Créez deux esquisses positionnées et 

utilisez-les pour créer deux extrusions.
a. Cliquez sur l'icône Esquisse 

positionnée.
b. Sélectionnez YZ plane (Plan YZ) 

comme référence d'esquisse.
c. Appliquez une esquisse au contour, 

puis quittez l'atelier Sketcher.
d. Dessinez une autre esquisse 

positionnée sur le plan YZ.
e. Quittez l'atelier Sketcher.

2a

1b

1c

2c

2d
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C'est à vous ! (2/11)

2. Créez des extrusions (suite…). 

f. Cliquez sur l'icône Extrusion.
g. Utilisez sketch.1 comme contour 

pour créer la première extrusion. 
Entrez [15mm] dans le champ 
Length (Longueur).

h. Cliquez sur l'icône Extrusion.
i. Sélectionnez sketch.2 comme 

contour pour créer la deuxième 
extrusion. Entrez [40mm] dans le 
champ Length (Longueur).

2f

2g

2g

2i

2i
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�

C'est à vous ! (3/11)

3. Créez une coque. 
� Pour pouvoir créer une coque, vous 

devez définir une épaisseur et des faces 
à retirer. 
a. Cliquez sur l'icône Coque.
b. Entrez [4mm] comme épaisseur 

intérieure.
c. Sélectionnez les surfaces à retirer.
d. Cliquez sur OK.

3a

3c 3c

3b

3d
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C'est à vous ! (4/11)

4. Créez une poche. 
� Pour pouvoir créer une poche, vous 

devez définir une esquisse à extruder.
a. Cliquez sur l'icône Esquisse 

positionnée. 
b. Sélectionnez la surface comme ci-

contre.
c. Tracez et contraignez le profil illustré ci-

contre.
d. Quittez l'atelier Sketcher.

4a

4b

4c
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�

C'est à vous ! (5/11)

4. Créez une poche (suite).

e. Sélectionnez l'icône Poche.
f. Spécifiez les valeurs de la définition de 

poche affichées.
g. Cliquez sur OK.

4e

4f

4g
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C'est à vous ! (6/11)

5. Créez un congé d'arête.
� Un congé d'arête est créé en définissant 

les arêtes et la valeur de rayon.  
a. Cliquez sur l'icône Congé d'arête.
b. Sélectionnez les arêtes.
c. Entrez [5mm] comme valeur de rayon.
d. Cliquez sur OK.

5a

5b

5c

5d
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C'est à vous ! (7/11)

6. Créez un filetage/taraudage. 
� Les filetages et les taraudages ne sont pas 

représentés visuellement dans 
l'environnement 3D ; même si le 
composant apparaît dans l'arbre des 
spécifications après sa création.
a. Cliquez sur l'icône Thread/Tap 

(Filetage/Taraudage).
b. Sélectionnez la surface ci-contre comme 

face latérale.
c. Sélectionnez la surface suivante : face 

limite.

6a

6b

6c
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C'est à vous ! (8/11)

6. Création d'un filetage/taraudage (suite). 

d. Entrez [15mm] comme valeur de 
profondeur de taraudage.

e. Cliquez sur Preview (Aperçu)
f. Cliquez sur OK.

6d

6e

6f
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C'est à vous ! (9/11)

7a

7. Réorganisation du composant Coque. 
� Après avoir revu le modèle, la poche 

créée devrait atteindre la face 
inférieure de la pièce. Le composant 
Pocket (Poche) doit être appliqué
avant la coque.

a. Sélectionnez le composant coque 
dans l'arbre des spécifications, 
faites un clic droit et choisissez 
Reorder (Réordonner).

b. Sélectionnez le composant 
Pocket.1 (Poche.1).

c. Cliquez sur OK.

7b

7c

Selon 
config.
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C'est à vous ! (10/11)

8. Modifiez les propriétés de composant. 
� Pour personnaliser l'affichage des 

composants créés, vous pouvez modifier 
leurs propriétés individuelles.
a. Sélectionnez le composant Pad.1 

(Extrusion.1) dans l'arbre de 
spécifications, faites un clic droit et 
sélectionnez Properties (Propriétés).

b. Cliquez sur l'onglet Feature Properties
(Propriétés de l'élément).

c. Spécifiez [Base] comme nom de 
l'élément

d. Cliquez sur OK.

8a

8c

8d

8b
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C'est à vous ! (11/11)

8. Modifiez les propriétés de l'élément 
(suite).

e. Sélectionnez le composant PartBody
(Corps principal), cliquez avec le bouton 
droit de la souris et sélectionnez 
Properties (Propriétés).

f. Cliquez sur l'onglet Graphic
(Graphique).

g. Modifiez la couleur de remplissage 
(comme indiqué).

h. Cliquez sur OK.

8g

8h

9. Fermez le fichier sans l'enregistrer.
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�

Récapitulatif de l'exercice : Filetage et taraudage

� Créer un filetage/taraudage

� Réorganiser un composant

� Modifier les propriétés d'un composant
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Exercice : Taraudage
Exercice : Récapitulatif

10 min

Dans cet exercice vous créerez un boulon en utilisant les techniques et outils que 
vous avez appris, sans instructions détaillées.

A la fin de cet exercice, vous serez 
capable de :

� Créer des taraudages.
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�

C'est à vous !

1. Créez la pièce boulon avec les cotations données ci-
dessous.
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�

Récapitulatif de l'exercice : Taraudage

� Création de taraudages
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Edition de composants
Dans cette section vous apprendrez à modifier des composants.

Suivez ces étapes :

1. Application d'une
dépouille. 

2. Création d'un raidisseur.
3. Création des filetages et 

des taraudages.
4. Modification de 

composants.
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Modification de composants

La modification et la manipulation de 
composants est souvent requise lorsque 
interviennent des changements dans l'objectif 
de conception ou une évolution des stratégies 
de modelage (en dehors des modifications de 
cotation). CATIA met plusieurs outils à votre 
disposition pour modifier des composants, 
notamment les outils suivants :
• Définition de l'objet de travail

• Réordonner

• Propriétés

• Filtres (Recherche)

• Composants Cacher/Afficher

• Parents-enfants

• Composants Désactiver/Activer

• Résolution d'erreurs de 
composant
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Options d'affichage de modèle

Cacher Afficher

Masquage des 
plans de 
référence et des 
esquisses. 

Désactivation des 
composants Trou.

Active Désactive

Il y a plusieurs options disponibles dans CATIA pour simplifier l'affichage. Deux des 
méthodes de simplification les plus connues sont Cacher/Afficher et Désactive/Active.
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Cacher/Afficher (1/2)

A

B

C

Les géométries filaires et surfaciques (telles 
que des esquisses et des plans de référence) 
peuvent être retirées de l'affichage pour 
contribuer à dégager l'écran. 

Vous pouvez cacher/afficher des éléments en 
utilisant plusieurs méthodes :

A. Cliquer avec le bouton droit de la souris 
sur le(s) élément(s) dans l'arbre des 
spécifications ou directement sur le 
modèle et sélectionner Hide/Show 
(Cacher/Afficher) dans le menu 
contextuel.

B. Sélectionner les élément(s) et cliquer sur 
l'icône Cacher/Afficher.

C. Pour cacher/afficher tous les éléments du 
même type vous pouvez également utiliser 
le menu Tools > Hide (Outils > Cacher) 
ou Tools > Show (Outils > Afficher).
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Cacher/Afficher (2/2)

A

B

CATIA a deux espaces visuels : visible et non 
visible. Les objets visualisables se trouvent 
dans l'espace visible, les objets non 
visualisables se trouvent dans l'espace non 
visible. 

Vous pouvez savoir dans quel espace visuel 
se trouve un élément en utilisant l'une des 
méthodes suivantes :
A. Les éléments cachés sont affichés dans 

l'arbre des spécifications en grisé.

B. Cliquez sur l'icône Afficher les objets 
cachés/affichés. Ceci vous place dans 
l'espace de travail non visible. Tous les 
éléments cachés sont affichés et tous les 
éléments affichés sont cachés. Pour 
retourner dans l'espace visible, cliquez à
nouveau sur l'icône Afficher les objets 
cachés/affichés.
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Analyse du modèle (1/2)

CATIA possède des outils permettant 
d'analyser un modèle. Vous pouvez utiliser ces 
outils pour déterminer de quelle manière un 
modèle a été conçu et pour vérifier les types 
de relations parent/enfant existants. 

Arbre de spécifications

L'arbre de spécifications est peuplé au fur et à
mesure de la création des composants. 
Utilisez-le pour déterminer la manière dont un 
modèle a été conçu. Les composants sont 
ajoutés dans l'arborescence dans l'ordre de 
leur création. Les enfants ne peuvent pas 
apparaître dans l'arborescence avant leur 
parent. Par exemple, le premier composant 
dans l'arbre des spécifications que vous voyez 
à droite est une extrusion. Déplacez le pointeur 
sur l'extrusion dans l'arbre afin de mettre en 
évidence l'extrusion dans le modèle.

L'arbre de spécifications est également utile 
lorsque vous procédez à des sélections. Au 
lieu de sélectionner des composants 
directement dans le modèle (ce qui peut être 
difficile parfois), il est plus facile de mettre en 
surbrillance les composants à l'aide de l'arbre 
des spécifications.
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Analyse du modèle (2/2)

Parcours du modèle

Le parcours du modèle permet d'examiner la 
création d'un modèle et d'un composant à la 
fois. Vous pouvez utiliser cet outil pour voir un 
enregistrement visuel étape par étape de la 
création d'un modèle (réalisé par un autre 
concepteur). Pour utiliser le parcours de 
modèle, cliquez sur Edition > Parcours ou 
définition de l'objet de travail. 

Parent/Enfant

Les outils parent/enfant permettent d'afficher 
tous les parents et enfants d'un composant 
sélectionné. Vous pouvez les utiliser pour 
vérifier les différents types de relations existant 
dans un modèle. Pour utiliser l'outil 
Parent/Enfant, cliquez avec le bouton droit de 
la souris sur le composant et sélectionnez la 
commande Parent/Enfant.
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Relations Parent-enfant

Les références existant entre composants 
soit par le processus de création soit par 
association sont des relations parent-
enfant. 
Pour visualiser les relations Parent-enfant 
d'un composant, sélectionnez le composant 
dans l'arbre des spécifications, faites un 
clic droit pour ouvrir le menu contextuel, 
sélectionnez Parents/Children
(Parents/Enfants). La fenêtre Parents and 
Children (Parents et enfants) apparaît, 
affichant le composant et ses références. 
Les composants de gauche sont des 
parents, les composants de droite sont 
leurs enfants.
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Rôle de la réorganisation des composants

L'ordre dans lequel les composants et les opérations s'affichent dans l'arbre des 
spécifications affecte la géométrie de la pièce. La modification de l'ordre est parfois motivée 
par l'ordre incorrect selon lequel les composants ont été créés ou par des modifications de 
l'objectif de conception. 

Sur l'image de gauche, un trou a été créé après l'opération de symétrie. La réorganisation 
du trou avant la symétrie donne le résultat montré sur l'image de droite. 

Un seul trou Deux trous après avoir réordonné
l'extrusion avant l'opération de 

symétrie
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Réorganisation de composants (1/2)

Suivez ces étapes pour réorganiser un 
composant :

1. Sélectionnez le(s) composant(s) 
réordonner et faites un clic droit de la 
souris.

2. Cliquez sur Reorder (Réordonner) 
dans le menu contextuel.

1

2



Principes de base CATIA V5- Leçon 5 : Composants d'habillage
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            5-75

Réorganisation de composants (2/2)

Suivez ces étapes pour réordonner un 
composant (suite) :

3. Sélectionnez le composant après lequel 
vous souhaitez placer les composants à
réordonner.

4. Cliquez sur OK.

3

4

3
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Limites de la réorganisation

Quand un composant est référencé par un autre composant pendant une conception, 
des relations parent/enfant s'établissent entre les deux composants. Cela signifie que le 
second composant (l'enfant) dépend du premier composant (le parent) pour une pièce 
de sa définition. Dans l'exemple ci-dessous, l'esquisse de la petite poche est contrainte 
avec la grande poche. Si vous essayez de réorganiser la petite poche avant la grande 
poche, CATIA vous rappellera, par un message, que ce n'est pas possible. Si ce 
composant a été réordonné, vous recevrez un message d'erreur de mise à jour en 
raison de la référence circulaire.
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Définit l'objet de travail (1/2)

Comme illustré dans les pages 
précédentes, l'ordre des composants peut 
affecter le résultat du modèle. La création 
d'un composant ne dépend pas 
uniquement (en termes d'objectif de 
conception) des composants créés avant 
lui, mais également des composants créés 
postérieurement. 
Il est donc parfois nécessaire de créer des 
composants à des stades antérieurs du 
modèle, au lieu de l'état courant. Ce sera 
fait à travers le choix correct de l'objet de 
travail. Quand un composant est défini 
comme objet de travail, tous les 
composants créés postérieurement sont 
ignorés et le modèle reste dans l'état dans 
lequel il était au moment de la création de 
ce composant.

Pour définir le composant en tant qu'objet 
de travail, sélectionnez-le et effectuez un 
clic droit pour ouvrir le menu contextuel, 
puis choisissez Define In Work Object 
(Définit l'objet de travail).
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Définit l'objet de travail (2/2)
L'objet de travail est souligné dans l'arbre 
des spécifications. Dans cet exemple, la 
poche Pocket.2 (Poche.2) est l'objet de 
travail et tous les composants avant ce 
composant sont  actifs. En définissant l'objet 
de travail sur des composant particuliers, le 
modèle peuvent être capturé sur des 
différentes étapes de conception. 

'Pocket.2' (Poche.2) est l'objet de 
travail.

Tous les composants existent.

A B

A. Dans le cas présent, le composant 
Shaft.1 est l'objet de travail. 
Uniquement le composant de 
révolution est visible parce qu'il n'y a 
pas de composants avant ce 
composant.

B. Dans le cas présent, le composant 
Hole.1 est l'objet de travail. Par 
conséquent, tous les autres 
composants, sauf Pocket.2, sont 
visibles.

1. Définissez le conteneur principal 
comme objet de travail avant 
d'enregistrer le document.

2. Vérifiez que le corps de pièce et le set 
géométrique final sont actifs avant 
d'enregistrer.

Pour obtenir la forme principale de la pièce :
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Désactivation/Activation

L'option Deactivate (Désactiver) permet de 
retirer provisoirement des composants du cycle 
de mise à jour du modèle. Le composant peut 
être réactivé à tout moment. Vous pouvez 
désactiver des composants en cliquant dessus 
à l'aide du bouton droit de la souris dans l'arbre 
de spécifications ou directement dans le 
modèle, puis en cliquant sur X.Object > 
Deactivate (Objet.X > Désactiver).

Lors de la désactivation d'un composant, les 
enfants de ce composant doivent être 
également désactivés. Les enfants sont définis 
comme des composants dépendant d'autres 
composants (parents). Par exemple, si 
l'extrusion affichée ci-contre est désactivée, le 
congé et le trou doivent être également 
désactivés. Le trou nécessite que la face de 
l'extrusion existe, alors que le congé nécessite 
que l'arête de l'extrusion existe.
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Résolution d'erreur dans les composants (1/4)

La création ou la modification de 
composants peut parfois entraîner des 
erreurs de définition du composant. Ces 
erreurs peuvent avoir diverses causes. 
Elles surviennent généralement en raison 
de références perdues lors de 
modifications ou parce que la géométrie 
ne peut pas être générée selon sa 
définition actuelle. 
Excepté ce dernier contexte d'erreur, 
quand un composant échoue, une boîte de 
dialogue Update Diagnosis (Diagnostic 
de la mise à jour) apparaît avec des 
détails sur la cause de l'erreur.
CATIA vous permet soit d'éditer le 
composant, soit de le désactiver, soit 
d'isoler ses références, soit de le 
supprimer.
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Résolution d'erreur dans les composants (2/4)

2

3

Dans le présent exemple, le congé d'arrête 
doit être supprimé car il n'est plus 
nécessaire.

Suivez ces étapes pour résoudre l'erreur de 
définition du composant :

1. Sélectionnez le composant EdgeFillet
(Congé arête), cliquez avec le bouton 
droit de la souris et sélectionnez Delete
(Supprimer).

2. Dans la fenêtre Delete (Suppression), 
vérifiez que l'option Delete all children
(Supprimer tous les enfants) n'est pas 
cochée, car vous ne voulez supprimer 
que le congé d'arête.

3. Cliquez sur OK.
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Résolution d'erreur dans les composants (3/4)

Suivez ces étapes pour résoudre une erreur 
de définition du composant (suite) :

4. Une fois que le composant est 
supprimé, tous les composants suivant 
EdgeFillet.1 apparaissent comme non 
mis à jour dans l'arbre de 
spécifications. Les composants non 
mis à jour sont identifiés par un 
symbole de mise à jour. 

5. L'icône Mise à jour complète est mise 
en surbrillance dans la barre d'outils
Outils.

6. Le modèle figure en rouge pour 
indiquer qu'il n'est pas entièrement mis 
à jour.

7. La fenêtre Update Diagnosis
(Diagnostic de la mise à jour) apparaît. 
Elle  indique un problème sur 
l'esquisse Sketch.2 (Esquisse.2), une 
arête n'est plus reconnue. 

8. Cliquez sur le bouton Edit (Edition).

5

7

8

4
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Résolution d'erreur dans les composants (4/4)

Suivez ces étapes pour résoudre une erreur 
de définition du composant (suite) :

9. L'environnement Setcher est ouvert 
pour pouvoir éditer l'esquisse 
Sketch.2 (Esquisse.2).

10. Visualisez l'esquisse et remarquez 
que la position du trou a été mesurée 
par rapport à l'arête supprimée par le 
congé. La référence de 
positionnement de trou a été
supprimée en même temps que le 
congé d'arête.

11. Supprimez les cotations et créez des 
cotations par rapport à l'arête 
existante, puis sortez de l'esquisse. 
Le problème est résolu.

Référence
manquante
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Propriétés (1/4)

L'apparence ainsi que la fonction des 
composants peuvent être personnalisées à
l'aide de la commande Properties
(Propriétés). Vous pouvez y accéder en 
sélectionnant le composant et en cliquant 
sur Edit > Properties (Edition > 
Propriétés) , ou en cliquant avec le bouton 
droit de la souris sur le composant et en 
sélectionnant les propriétés dans le menu 
contextuel.

Les propriétés d'un composant sont 
regroupées dans trois onglets :

• Mécanique

• Propriétés de l'élément

• Graphique
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Propriétés (2/4)

Mécanique
� L'onglet Mechanical (Mécanique) 

vous donne des informations sur l'état 
de la mise à jour du composant.
L'option Deactivated (Désactivé) est 
la seule option que vous pouvez définir 
manuellement. Cette option désactive 
essentiellement le composant de façon 
qu'il ne soit pas évalué pendant la 
régénération. En définissant cette 
option, vous pouvez également 
appliquer cette propriété aux éléments 
affectés. 

� L'option Associate stop update 
(Interrompre la mise à jour) vous 
permet d'arrêter la mise à jour de ce 
composant et d'afficher un message 
personnalisé. Elle est utile si vous 
modifiez d'autres zones de la pièce et 
si vous voulez que ce composant soit 
mis à jour uniquement sous certaines 
conditions.
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Propriétés (3/4)

Propriétés de l'élément
� L'onglet Feature Properties (Propriétés 

de l'élément) vous permet d'attribuer un 
nom personnalisé au composant. 

� Cet onglet affiche des informations 
concernant la personne qui a créé la 
pièce, la date de création et de dernière 
modification.
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Propriétés (4/4)

Graphique
� Dans l'onglet Graphic (Graphique), 

vous pouvez personnaliser la couleur, 
l'épaisseur et le type de trait des 
différentes entités du composant.

� Vous pouvez également spécifier les 
propriétés de calque (utilisé pour filtrer 
les éléments graphiques) et le 
comportement de l'élément par rapport 
à ces propriétés.
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Recherche (1/4)

Dans une pièce complexe contenant 
beaucoup de composants vous pouvez 
avoir besoin de positionner des éléments 
particuliers pour les modifier. 
CATIA vous permet de rechercher des 
éléments particuliers en utilisant plusieurs 
critères. 
Pour accéder à cette fonctionnalité, cliquez 
sur Edit > Search (Edition > Recherche).

La fenêtre de recherche contient trois 
onglets définissant trois types de méthodes 
de recherche :

• Générale

• Avancée

• Par favoris
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Recherche (2/4)

Générale
L'onglet General (Générale) vous permet de 
rechercher en utilisant l'un des trois critères :

• Name (Nom)
• Recherche le modèle du composant. 

Vous pouvez également utiliser 
l'astérisque (*) comme caractère 
générique et définir la recherche avec le 
critère Case sensitive (Sensible à la 
casse). Par exemple Connector* 
recherche tous les noms d'éléments qui 
commence par "Connector".

• Type
• Recherche le modèle pour un type de 

composant particulier associé à un 
atelier particulier. Par exemple (Part 
Design – Extrusion).

• Color (Couleur)
• Recherche le modèle dont les éléments 

ont une couleur particulière.
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Recherche (3/4)

Avancée
• L'onglet Advanced (Avancée) vous 

permet d'utiliser les mêmes techniques 
de recherche que dans l'onglet 
General (Général). Mais vous pouvez 
les combiner dans des expressions 
booléennes plus complexes. 

• Pour créer la recherche illustrée ci-
contre, sélectionnez l'atelier, le type et 
l'attribut. Cliquez ensuite sur le bouton 
And (Et) et sélectionnez un autre 
groupe de critères. Remarquez 
également qu'il n'est pas obligatoire de 
remplir les trois champs ; vous pouvez 
créer la recherche en utilisant 
n'importe quelle combinaison de 
champs.
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Recherche (4/4)

Par favoris
• Les recherches effectuées dans les 

onglets General (Générale) et Advanced 
(Avancée) peuvent être enregistrées dans 
une liste de favoris. Une fois la recherche 
exécutée, l'icône Add Favorites (Ajouter 
aux favoris) est active et vous pouvez 
personnaliser son nom. Une fois la requête 
ajoutée, elle apparaît dans la fenêtre 
principale de l'onglet Favorites (Favoris).
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Recommandation sur la désactivation
Dans cette section, vous découvrirez une recommandation qui peut vous aider lors de 
la désactivation de composants et l'investigation d'un modèle.
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Aucun composant désactivé dans un document chargé (1/2)

1. Dans l'exemple présenté, EdgeFillet.1 est positionné
juste après Pad.1. Il pourrait être moins visible que les 
quatre autres composants désactivés qui sont 
regroupés en bas de l'arborescence. 
a. Activez les quatre derniers composants dans 

l'arborescence.

Il est déconseillé de conserver des composants désactives 
dans un document à enregistrer. Même s'il est possible 
qu'un document en cours comporte des composants 
désactivés, le document publié final NE doit PAS contenir 
de composants inutiles.

Soyez particulièrement attentif à la présence de 
composants désactivés dans une pièce complexe.

1a
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Aucun composant désactivé dans un document chargé (2/2)

b. Vous pouvez ensuite remarquer qu'il 
manque un congé sur les deux coins 
supérieurs.

c. Créez un congé sur ces deux arêtes pour 
améliorer la conception.

d. Ultérieurement, le congé désactivé, 
EdgeFillet.1, est identifié et réactivé. Un 
message d'erreur s'affiche.

1b

1c

2. Ce scénario peut se produire dans une pièce 
plus complexe. Il pourrait ensuite donner 
naissance à une erreur de mise à jour 
ultérieurement dans le cycle de conception.

1d
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Pratiques de conception 

Lorsque vous modélisez dans CATIA, il est fondamental de comprendre que les étapes 
suivies pour créer le modèle sont aussi importantes que le résultat final.

Choisissez avec beaucoup de précaution les meilleurs composants de base, les 
relations parent/enfant, les cotations et l'ordre des composants qui reflètent le mieux 
l'objectif de conception. 

Bon nombre de pratiques de conception sont issues de normes d'entreprise et doivent 
être prises en compte avant le lancement de la modélisation. Voici quelques pratiques 
de conception couramment employées :
� Essayer d'éviter de créer des références pour les composants d'habillage comme les 

congés et les chanfreins. Ces composants peuvent être supprimés dans des 
applications en aval.

� Utilisez systématiquement une esquisse positionnée lors de la création d'un contour 
esquissé.

� Toujours choisir le composant le plus stable du modèle comme composant de base.

� Choisir la meilleure option de profondeur pour l'application. Par exemple, décidez s'il 
est indispensable qu'une poche traverse toujours le modèle entier. La création d'une 
poche avec une profondeur cotée n'est pas recommandée parce que la profondeur du 
composant à couper peut être modifiée. Créez plutôt la poche avec l'option de 
profondeur Jusqu'au dernier.
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Pour résumer...

En utilisant les informations données dans cette leçon, vous créerez le capot 
supérieur (comme indiqué).

Pour créer le capot vous devez :

� Créer un composant de dépouille
� Créer des raidisseurs
� Editer des propriétés de composant
� Créer des taraudages
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Etude de cas : Composants d'habillage
Exercice : Récapitulatif

25 min

Vous allez mettre en pratique ce que vous avez appris en réalisant le modèle de 
l'étude de cas : seuls un dessin détaillé et des conseils seront à votre 
disposition pour vous guider.

Dans cet exercice, vous allez créer le modèle d'étude de cas. Gardez en 
mémoire l'objectif de conception du modèle :

� Les nervures intérieures doivent être créées à l'aide des composants 
de raidisseur.

� Le capot doit contenir une dépouille de quatre degrés.

� Le capot doit avoir des taraudages définis pour tous les trous.

Utilisez les techniques que vous avez apprises dans 
cette leçon et les leçons précédentes pour créer le 
modèle sans les instructions détaillées.
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�

C'est à vous : Dessin du capot supérieur

Créez le modèle grâce au dessin proposé.
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�

Etude de cas : Capot supérieur (Récapitulatif)

� Les nervures intérieures 
doivent être créées à l'aide 
des composants de 
raidisseur.

� Le capot doit contenir une 
dépouille de quatre degrés.

� Le capot doit avoir des 
taraudages définis pour 
tous les trous.




